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1 About the chapters of this
manual

In the following, we give a brief summary of each chapter in this manual.
These summaries will help you find the information you are looking for.

Chapter 2 “An introduction to HELIOS EtherShare” gives background infor-
mation about the components that make up EtherShare.

Chapter 3 “HELIOS Admin” briefly shows how to manage EtherShare related
tasks such as configuring AFP volume settings, PAP printer settings, etc. with
the HELIOS administration program.

Description of the server software modules

Chapter 4 “TCP/IP configuration” describes how to set up AFP server and
volume access lists.

Chapter 5 “The EtherShare file server” describes the function, the configura-
tion, and the operation of the file server. It explains how the administrator can
define access privileges for EtherShare Mac OS 8/9 and OS X users.

Chapter 6 “The EtherShare print server” explains the “papsrv” and describes
how to configure printers manually.

Chapter 7 “EtherShare utility programs” introduces EtherShare utility pro-
grams and describes them in detail.

Chapter 8 “EtherShare client applications” introduces and explains EtherShare
client applications such as the HELIOS Meta plug-in or HELIOS LanTest.
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Chapter 9 “Preferences” lists the EtherShare preferences and explains what
they effect when set.

Additional information

Appendix A “Files in the HELIOS directory” lists the files that belong to the
EtherShare installation.

Appendix B “Glossary” explains some product related terminology.
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2 An introduction to HELIOS
EtherShare

This manual addresses EtherShare environments with OS X clients. If you are
using classic Mac OS up to Mac OS 9.x, please refer to the EtherShare 2.6
manual. This is available on the HELIOS website.

The software which makes up EtherShare provides file server functions for
Mac computers connected together in an AFP network. EtherShare is based
on powerful multitasking/multiuser features. With EtherShare, it is very easy
to expand the power of your network at a later date, when the amount of work
and the number of users increase.

Note: HELIOS EtherShare runs on top of the foundation provided by HELIOS
Base. Please read the HELIOS Base manual for installation instructions
and other important details.

File server

While maintaining complete compatibility with the AFP specification, the
EtherShare file server allows access to documents and applications throughout
the whole network.

To network your host system and thus your Mac computers with Windows PC
compatible computers use PCShare. To provide real-time remote file access
for web clients, use WebShare (see B “Glossary”).

HELIOS Admin server and HELIOS Admin

The cross-platform program HELIOS Admin is an administration tool which
can be used to configure EtherShare from any connected client workstation. It

http://www.helios.de/manuals
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can also be used by regular users to check the configuration. However, they
are prevented from making any changes.

HELIOS Admin communicates with EtherShare through the HELIOS Admin
server, which runs on the host while HELIOS Admin needs to be installed on
the client workstation. The communication between these two programs takes
place through a TCP/IP connection which allows managing multiple servers
remotely and supporting concurrent TCP/IP connections (see “Logging on to
the HELIOS Admin server” in the HELIOS Base manual).

Print server and font server

The EtherShare print server program (“papsrv”) is a central spooler for print
jobs destined for PostScript devices such as PostScript printers and photo-
typesetting machines.

One or more printers can be connected to EtherShare simultaneously either
through TCP/IP, or connected directly to the host via a serial interface. Print
jobs are received from the network and temporarily stored on the host before
being sent to the assigned printer (print spooling). This considerably improves
the throughput of the workstations on the network, since they can immediately
dispatch their print jobs and do not have towait for the printer. Other connection
types are also supported (see 6 “The EtherShare print server”).

EtherShare allows PostScript devices to be directly connected to the print
server via a serial interface, so it is not necessary for them to support the
Apple PAP (Printer Access Protocol). The interface between such printers
and networks is implemented in the print server, which allows such printers
to be accessed from any workstation as if they were directly connected to the
workstation. However, problems may occur with applications that send images
as binary bitmap data, since serially connected PostScript printers interpret
certain binary codes as control signals. Accordingly, we recommend network
connected printers, which are able to handle 8-bit data (see 6.4 “Configure
printers manually”). In addition, it is much faster than a serial connection,
which is an important factor, e.g. for images.
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All printers should be driven through the print server, in order to take advantage
of the EtherShare print job spooling feature – please select the corresponding
printer queue from Apple’s “Printers & Scanners” system preferences pane
and NOT the printer which the queue is connected to.

In addition to printing to the assigned printer and providing spooling functions,
the print server automatically interprets messages returned by the printer and
forwards them to the appropriate user via e-mail and the “srvmsg” tool. Apart
from convenience, this feature allows rapid reaction to situations such as “paper
out” or “paper misfed”.

The font server is an integral part of the print server. It reduces network loading,
increases throughput and allows central administration of printer fonts. See
Font including (Mac OS 9 clients only!) in 6.2 “The print server in operation”
for information on this feature.

2.1 EtherShare on Windows

On Windows platforms, HELIOS EtherShare adds full AFP compatibility for
Mac network clients to connect to Windows volumes and printers. HELIOS
EtherShare on Windows offers the same user experience as on other HELIOS
server platforms, including support for Spotlight search, and Time Machine
backups to EtherShare volumes. Administrators will note that the “dt” tools
are slightly different on Windows, with the primary difference that “dt sync”
is not included. Hence the “Syncs” tab does not appear in HELIOS Admin

Note: Within this manual, “UNIX” is used frequently. Generally, when referring to
a server, it can be read as UNIX or Windows server. However, the Windows
NTFS file system, and the UNIX file systems are different in many respects.
So topics related to the UNIX file system, may or may not be applicable to
the Windows server.
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2.2 EtherShare client applications

There are several HELIOS drivers and applications included for installation
or use on Mac network clients utilizing HELIOS server volumes and print
queues.

m HELIOS Permissions (described in 8.1 “HELIOS Permissions”)

m HELIOS TCP Printer driver (described in 6.3 “HELIOS TCP Printer”)

m HELIOS Admin application (described in 3 “HELIOS Admin”)

m HELIOS Meta plug-in (described in 8.4 “The HELIOS Meta plug-in”)

m HELIOS LanTest (described in 8.5 “HELIOS LanTest”)

m HELIOS Spotlight search (described in 8.6 “HELIOS Spotlight search”)

m HELIOS WebShare Manager, which facilitates project collaboration, with
automatic file synchronization (described in its own manual)

Note: The EtherShare client applications distributed with HELIOS G8 run on
OS X 10.11 and later. Users with older Macintosh clients can install an
older HELIOS software suite, e.g. CD026, and then do an overinstallation
with HELIOS CD027. This enables the “Unsupported” folder in “HELIOS
Applications > MacOS” which contains software versions of the EtherShare
client applications that will work with client workstations prior to OS X 10.11.

The “Client software installation checklist” (“HELIOS_Install_Checklist.pdf”)
lists all the options, and is included in the “Documentation” folder in the
“HELIOS Applications” volume.
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2.3 New EtherShare features

For new features in the EtherShare software see the HELIOS website:
www.helios.de Go to HELIOS Product Versions – New Features

For HELIOS Base, the foundation used by all HELIOS products, see the
HELIOS Base product web page:
www.helios.de Go to Products > Base

https://www.helios.de/web/EN/products/new-features.html
https://www.helios.de/start.html?lang_id=en
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3 HELIOS Admin

This cross-platform based administration service is comprised of two compo-
nents, the HELIOS Admin server and the HELIOS Admin client.

The HELIOS Admin client is a convenient tool that allows configuring users,
groups, volumes, printer queues, etc., and which is supported for various client
platforms due to its Java heritage. For details see the chapter “HELIOS Admin”
in the HELIOS Base manual.

In this manual we focus on the EtherShare related usage of HELIOS Admin,
such as configuring AFP volume settings or PAP printer settings.

Note: EtherShare administration server and EtherShare Admin are being phased
out by HELIOS, so it is recommended to use the cross-platform HELIOS
Admin instead. For details on EtherShare Admin, refer to the EtherShare
2.6 manual on the HELIOS product CD or in the “HELIOS Applications”
volume.

3.1 General remarks

This chapter describes the use of the application HELIOS Admin to perform
EtherShare related configuration from any workstation in a convenient and
secure way.

In order to use HELIOS Admin, the HELIOS Admin server must already be
running on the host you want to configure. The HELIOS Service Controller is
configured to start this service automatically when the system is booted.



10 3 HELIOS Admin

Other chapters in this manual describe how administrative work, which is
required to configure and maintain the EtherShare system, can be done directly
on the host, e.g. by using “prefvalue” (see “HELIOS utility programs” in the
HELIOS Base manual). However, most of these tasks can be carried out much
easier using HELIOS Admin from one of the workstations.

HELIOSAdmin offers a high degree of convenience to the system administrator.
The application allows the host configuration to be represented graphically
with lists and windows. Using HELIOS Admin from any workstation, server
users, groups, volumes, and printers can be installed, configured and deleted.
You can also interrogate each PostScript printer for available resident fonts
and install downloadable fonts to the print server.

HELIOS Admin accesses and modifies the “Preferences” configuration file.
HELIOS Admin and the HELIOS Admin server have built-in safety checks to
avoid conflicting or invalid configuration settings.

HELIOS Admin has the additional advantage that almost all changes are
immediately effective, without having to restart the affected service.

Benefits:

m Any new suffix mappings or changes to existing ones will be available
immediately.

m Any new HELIOS volume or printer will be available immediately.

m Any changes to HELIOS volumes, e.g. setting groups membership, will
be available immediately.

Potential drawbacks:

m Any changes to HELIOS volumes, e.g. removing or changing mount
points, switching characteristics to read-only or changes in groups mem-
bership may result in side effects for EtherShare clients, in case the volume
is still mounted. This may range from write errors to volumes getting
dismounted(!).
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m Especially important – Removing access rights to volumes for clients that
still have documents open on that volume might cause damaged or only
partially saved documents.

Make it a habit to check the Active Users list prior to making any changes
that might affect connected users. In this list you can check which users have
certain volumes in access.

3.2 Server settings

In the Settings > Server Settings window (Fig. 3.1), in the Mac tab, you can
specify the Server Name (if no server name is specified here, the system uses the
host name) and select the Default Client Charset. From the IP Access pop-up
menu choose the desired IP access list for the server. The chapter “HELIOS
Admin” in the HELIOS Base manual describes in detail how to edit the default
IP access list according to your needs.

Note: If you wish to share HELIOS server volumes on a OS X server platform
running native AFP file sharing, the HELIOS server should be assigned a
Mac server name (Server Name in Fig. 3.1) that is different from the OS X
server name.
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Fig. 3.1: “Server Settings” window

3.3 Volume AFP settings

This chapter refers to AFP related volume settings only. For general information
on volume settings and instructions on how to change them see “Volume
settings” in the “HELIOS Admin” chapter of the HELIOS Base manual.

The Volumes list shows all HELIOS volumes on the host (Fig. 3.2). TheHELIOS
Admin server automatically creates this list by inspecting volume-related
entries in the “Preferences” file (see “Volume preference keys” in the HELIOS
Base manual).

â Choose the Volumes tab. If it is not available, activate it in the Lists menu.
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Fig. 3.2: Volumes list on host “ankh”

Changing AFP volume data

Before changing AFP volume data, make sure that the volume is not in use. All
users should unmount the volume, because changes take effect immediately
and this could lead to strange effects.

â Select the volume name, and choose Open from the File menu (or double-
click the volume name).

The Mac tab displays the AFP information about the selected volume (Fig. 3.3).

The Mac Visible checkbox determines whether the volume is visible at all in
the Mac Connect To Server... dialog.
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Fig. 3.3: Mac tab on host “ankh”

The AFP Name field allows specifying the name by which the volume is published
in an AFP environment, and which is visible in the “AFP Name” column
(Fig. 3.2). The AFP volume name can have up to 255 characters.

The Password field allows specifying a volume specific password, which Mac
clients must enter prior to mounting the volume.

Important: The Password option is only valid for AFP users. In case the volume is also
published via PCShare for Windows this option remains without effect for
these users!
As of OS X 10.11 the AFP volume specific password feature is no longer
supported. If there are clients in the network running OS X 10.11 or newer
this feature should not be used anymore.
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From the AFP Charset pop-upmenu you can choose the AFP character encoding
which is used by older clients without Unicode support:

• EUC-KR

• MacArabic

• MacCentralEurRoman

• MacCyrillic

• MacGreek

• MacIcelandic

• MacRoman

• MacRomanian

• MacTurkish

• SJIS

If AFP UNIX Permissions is NOT active (default), a folder inherits the permis-
sions of the parent folder when used with OS X clients.

Note: This option is not available if EtherShare is installed on a Windows platform.
However, this option can be activated using the useunixperm preference
(see “Preferences” in the HELIOS Base manual).

The Time Machine Backup checkbox (see Server setup in 5.7 “Time Machine”)
must be activated to enable Time Machine backups for the volume.

3.4 Printer spooler settings

This chapter refers to Mac related printer settings. For general information on
printer settings, e.g. how to create and delete printers, see “HELIOS Admin”
in the HELIOS Base manual.

The Printers list shows all HELIOS printer queues on the host (Fig. 3.4). The
HELIOS Admin server automatically creates this list by inspecting printer-
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related entries in the “Preferences” file (see “Printer preference keys” in the
HELIOS Base manual).

â Choose the Printers tab. If it is not available, activate it in the Lists menu.

Fig. 3.4: Printers list on host “ankh”

Before changing printer data, make sure that the printer is currently not in use.

â Select the printer, and choose Settings from the Printer menu (or double-
click the printer name while holding down the o key).

The Mac tab displays information about the selected printer (Fig. 3.5).

LPR Bonjour Registration

For basic printing without any queue setup and without PPD synchronization,
the LPR Bonjour Registration can be enabled. Then the printers will appear
automatically in the OS X printer configuration. No additional client setup is
required. 6.3.2 “Create a new printer” describes the configuration of a new
printer.

HELIOS TCP

The TCP Name field in the TCP Printer section specifies the name by which the
TCP printer is registered by HELIOS mDNS (“Bonjour”), and by which this
printer can be reached via the master TCP port. The TCP name of the printer
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only becomes visible in the network if the TCP Printer checkbox is active.

Fig. 3.5: Mac tab on host “ankh”

For instructions on how to create and configure a HELIOS TCP Printer see
6.3.1 “Client configuration”.

Optionally, a dedicated TCP/IP port can be set:

â Specify a port number for the TCP printer in the Port field.

Defining a port may be helpful to share a TCP/IP queue over the internet. By
default all EtherShare printer queues are handled on port 2007.
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4 TCP/IP configuration

4.1 AFP server access

By default, the server accepts connections from all known TCP/IP interfaces.
When a client browses the network for an AFP server, it will respond with a
list of all known server TCP/IP addresses.

Sometimes it may be required to hide some interfaces or TCP/IP addresses.
This can be done via the ipaddress preference, which is described in 9.1 “AFP
server preference keys”.

In addition, a TCP/IP access list allows limiting incoming connections from a
list of specified TCP/IP addresses. See ipaccess in 9.1 “AFP server preference
keys”.

4.2 IP access list

HELIOS products include many different services which can be accessed very
easily for intranet usage. For using the HELIOS services on both the intranet
and internet, additional security considerations must be taken into account,
e.g. you do not want everyone launching OPI layout image generation by
issuing commands on the “opisrv” telnet port. Another problem is that not all
volumes should be available for internet users. And you certainly do not want
unauthorized internet users printing to your server printer queues. Making the
main server accessible from the internet bears a major problem: due to the
variety of different services running on the server it is possible that there is still
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a way for hackers to find some services which they can use to break into your
system. If you need a 100% warranty that your system is secure you probably
need to decide to run a local intranet only, and have no gateway services to or
from the internet.

In addition to the HELIOS services, UNIX includes many services, NFS,
telnet, ftp, rlogin, etc. A simple way to verify active services is the netstat

-a | grep -i listen command. One option to bring some services into the
internet is to use two network adapters, one for the intranet and a second for
the internet, e.g.:

le0 172.16.0.1 Intranet network
le1 193.141.98.37 Internet network

Note: UNIX IP routing/forwarding is not required and should be turned off between
these two networks.

The best solution to disable all HELIOS services for connections from the
internet is to turn all HELIOS services off for the internet 193.141.98.x network
by using the HELIOS TCP/IP access list feature, which can be managed from
HELIOS Admin or by using a UNIX text editor. A sample configuration of
“HELIOSDIR/var/conf/ipaccess” is:

allow 172.16.0.0/255.255.0.0 #Intranet Network
deny 0.0.0.0/0

This configuration will basically deny all access from the internet with the
exception of the 172.16.x.x network, which can use the HELIOS services.

4.2.1 Volume access list

One sample configuration is to allow internet access for one AFP server volume
but deny it for all other volumes. First it is required to allow the “afpsrv” process
to accept connections from the internet. This can be done in HELIOS Admin,
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Settings > Server Settings by selecting DEFAULT from the pop-up menu in the
Mac tab, and edit this file according to your needs.

Then, access on a per volume basis can be configured in the volume settings
(<volume name> > IP Access) by selecting the desired access list from the pop-up
menu (see Fig. 4.1).

A description of how to edit the IP access file or set up new ones, is given in
the HELIOS Base manual.

Fig. 4.1: Volume IP Access
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5 The EtherShare file server

This chapter is devoted to the EtherShare file server. The function, the config-
uration and the operation of the file server is described. In addition we include
information to allow the administrator to set up users, groups and volumes,
create folders, and define access privileges. Finally, we describe methods for
archiving data in the file server volumes to mass storage.

5.1 The file server program

The EtherShare file server system, “afpsrv”, is located in “HELIOSDIR/sbin”.
The server is usually configured to start “afpsrv” automatically upon system
boot.

Note: EtherShare “afpsrv” uses the default port 548. On OS X, if the native AFP
services are already running on this port, EtherShare uses a random free
port. See the note adjacent to afpport in 9.1 “AFP server preference keys”
for instructions on how to assign a certain free port number for “afpsrv”.

afpsrv

“afpsrv” is the program that implements the AFP (Apple Filing Protocol) file
server functions. It waits for filing requests from a client on the network, which
are then immediately processed. Each new login request results in a separate
“afpsrv” process being created. Accordingly, when a number of users access
the file server at the same time, a number of “afpsrv” processes run on the
host simultaneously. “afpsrv” is capable of supporting the following modern
features:
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m Spotlight search support

m OS X extended attributes support

m Finder permissions extension

m Finder Tags support (in Finder and Spotlight searches)

m Large file support, no 4 GB limit for archive, prepress and video data

m Unicode/UTF-8 file and volume names

m Long file name support up to 255 characters

m OSX symlink support for files allows copying application packages to/from
the server, without loss of information

m Client/server reconnect and client sleep support

m Full OS X compatibility (OS X 10.3 or newer recommended)

m 2-3 times faster performance than NFS or SMB/CIFS file sharing

m UNIX file/folder permissions for OS X clients

m Apple Time Machine support

File streams

A file in the Windows/NTFS environment can have a certain number of file
streams. File streams contain meta data such as creation or modification date
information, icon information, etc., similar to the resource fork of a Mac
file. If you manipulate files which have been created in a Windows/NTFS
environment, “afpsrv” supports file streams (see NTFS file streams support in
the HELIOS Base manual).
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Welcome and shutdown message

You can specify both a welcome message and a shutdown message to be
output on Mac workstations when they log in to EtherShare. There are no
preferences to set for this feature. Instead, create two text files “login.msg”
and “shutdown.msg”, and store them in the “MacOS” folder of the “HELIOS
Applications” volume. Then the messages will automatically be used by the
file server during login and shutdown. Usually, only the administrator has
write privileges to this directory (volume).

For example, the two messages could be: “Welcome to the Support server
of HELIOS Software GmbH” and “The Support server of HELIOS Software
GmbH has now been shut down”.

Note: If you are running EtherShare on a demo license you cannot modify the
default welcome message.

OS X 10.9 or newer clients do no longer support AFP messages. So there is
no message displayed on such clients.

A maximum of 199 characters will be displayed (excess characters are trun-
cated). If you want to include national accented characters such as Umlauts in
your messages, an UTF-8 capable text editor should be used.

Long file names on Mac OS 8/9

Mac OS 8/9 has no support for AFP 3.1 or later, AFP 2.2 is used instead.
As a result, file/directory names containing more than 31 characters will be
truncated. In this case the file name, beginning with the 26th character, is
replaced with a hashmark (“#”) followed by a four hexadecimal character
checksum. It is possible to rename these files to a different file name fromMac
OS 8/9. Working on files with truncated names is not recommended though.
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5.2 Directory and file formats

On UNIX machines, the EtherShare file server simulates the Mac’s HFS
(Hierarchical File System) on UFS (UNIX File System); the latter is found in
many UNIX variants. Due to the differences between these two systems, the
same Mac file appears differently when it is viewed through the UNIX file
system compared to when it is viewed from a Mac workstation.

The structure of volumes and files

In EtherShare, each HFS volume is mapped to a specified part of the UNIX
file system and mounted at a specified directory. This directory is then the
root directory of the volume.

You specify the volume mount point when setting up new volumes with
HELIOS Admin.

In contrast to files on DOS and UNIX, all Mac files are associated with so-
called “Finder info” contained in the file’s directory entry, which stores among
other things the file type and creator, the file creation date, etc.

Each file is split into two parts, the “data fork” and the “resource fork”. This
“split” is normally invisible to the Mac user; the “Finder info” in the file’s
directory is also invisible.

On EtherShare, the file’s data fork is stored with the chosen file name in the
UNIX directory corresponding to the folder.

The file’s resource fork is combined with the Finder info and stored in a separate
“resource file” of the same name in the so-called “resource” directory, which
is the “.rsrc” subdirectory of the folder’s directory.

A description of the resource file structure is available on the HELIOS website.

Mac file names invalid for UNIX are converted according to a specified algo-
rithm. For example, the question mark is coded as ^3f on the server:
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Hexadecimal Usual representation
22 "
2a *
2f /
3a :
3c <
3e >
3f ?
5c \
5e ^
7c |

When you create a folder on EtherShare, which you do with the Finder in the
normal way, a UNIX directory is created with the same name as the folder.
Folders also have Finder info, which stores among other things the folder’s
window position and size, and the viewing style (Mac OS 9). The Finder
info for a folder is stored in the parent’s folder “resource” directory, which is
created automatically when the folder is created. See Create new folders on
UNIX in 5.5 “Access privileges” for related information.

Assumed you have a file “Test” in folder “Demo” which is in “dave’s” home
volume. On UNIX you will have:

/home/dave/Demo/Test File’s data fork
/home/dave/Demo/.rsrc/Test File’s resource fork
/home/dave/.rsrc/Demo Folder’s Finder info

Furthermore, if for example the volume mount point is “/home/apps”, the
volume desktop is contained in the UNIX file “/home/apps/.Desktop”. The
“Network Trash Folder” for the volume is contained in the UNIX directory
“/home/apps/Network Trash Folder” and in the file “/home/apps/.rsrc/Network
Trash Folder”. Finder info for the root of the volume (viewing style, layout info
etc.) is contained in “/home/apps/.rsrc/^^volrsrc”. See “The desktop server”
in the HELIOS Base manual for related information.
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The file names “.Desktop”, “.DeskServer”, and the “.rsrc” folder are protected
by EtherShare, and cannot be accessed from a Mac client.

Inside a HELIOS volume, “.rsrc” directories can only be missing if folders
were created manually from UNIX or if “.rsrc” folders were removed manually
from UNIX. “afpsrv” automatically creates missing “.rsrc” directories for
every folder opened from the Mac in case a “.rsrc” directory is available in the
volume root directory of the HELIOS volume. This applies to files as well;
if “.rsrc” folders are available, resource files inside the “.rsrc” folder will be
created automatically.

The file type and creator are used by the Finder to select the right icon to display.
They are each 4 bytes long. The file creator is also used to automatically find
and start the corresponding program when you double-click on the icon of a
document. The icons themselves are stored in the desktop file, which exists
only once for each volume. Each application is usually associated with a single
file creator code (e.g. “MSWD” for Microsoft Word), but can as well have
several file type codes (e.g. “WDBN” for normal Word documents, “WHLP”
for Word help files, “DCT5” for the Word dictionary, etc.). See Icon data in
“The desktop server” in the HELIOS Base manual for more information.

Safe file management

HELIOS volumes store Mac native files (including resource forks and Finder
info) and Windows native files (including NTFS streams) in a format com-
patible with the server file system. When file operations are performed via
EtherShare or PCShare clients, all of the associated file components are trans-
parently acted upon, and the volume desktop database file (“.Desktop”) is
updated. Hence it is always recommended to perform file operations from
HELIOS clients. In situations where it is necessary to manipulate files in
HELIOS volumes directly on the server, it is essential to use the HELIOS
“dt” tools instead of the corresponding UNIX commands. The “dt” tools will
properly perform file operations, and therefore should be used for all command
line operations, in automated scripted workflows, for restoring backups, etc.
Refer to the HELIOS Base manual for details.
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UTF-8 encoded file names

HELIOS volumes use Unicode based file names in UTF-8 encoding. Therefore
special characters such as Umlauts can be used on different platforms (Mac
and PC clients) because modern clients offer full Unicode support. Exceptions
are listed in the The structure of volumes and files conversion table.

Non-UTF-8 encoded file names

In a non-UTF-8 volume, Mac special characters are automatically translated
by the EtherShare file server into a three-character escape sequence, but in
this case led by a leading colon (:) instead of the caret (^). For instance, the
special character “ä” is translated into “:8a” (MacRoman encoding).

However, accented characters (Umlauts) are not recommended for user names
and passwords (otherwise you will need to remember different passwords for
Mac and UNIX logins). Your UNIX host name must never include a slash
character (for example “my_rs/6000”).

Note: It is not possible for an AFP 3 client to mount a non-UTF-8 volume from the
EtherShare file server in the Finder. Any attempt will fail and the following
message is written to the syslog file:
volume: <volume name> without UTF8, unsupported, disabled

Generic file types

Finder info for UNIX files, which do not have resource files, are simulated
automatically as “generic file types” by EtherShare. EtherShare automatically
recognizes about 20 UNIX file types (shell script, socket etc.), and simulates
the Mac file type and creator. EtherShare will create a suitable resource
file when the corresponding folder is first opened. The resource file will be
ignored by UNIX applications, but allows EtherShare to recognize the file type
immediately the next time the folder is opened. EtherShare also recognizes
TIFF and EPSF files, but it cannot automatically create the PICT resource
for EPSF files. The following special UNIX file types are recognized directly
(type and creator are also shown):
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Description Type Creator
Block device BDEV UNIX
Character device CDEV UNIX
Socket SCKT UNIX
Named pipe PIPE UNIX

With normal UNIX data files, the file server tries to determine the file type
by examining the first 512 bytes of the file, in order to place it into one of the
following groups:

Description Type Creator
Executable file EXEC UNIX
Executable SCRIPT file TEXT UXSC
Object file OBJ UNIX
Archive file AR UNIX
CPIO archive file CPIO UNIX
Lempel-Zev compressed file COMP UNIX
Huffmann packed file PACK UNIX
SUN raster image file RAS UNIX
PostScript file (including EPS) TEXT UXPS
Mailbox file TEXT UXMB
TIFF file TIFF UNIX
Gnu Zip file Gzip UNIX
PDF file PDF /TEXT CARO
EPSF file EPSF UNIX
Text file TEXT UNIX
Binary data file DATA UNIX
No permission NOPE UNIX
Unreadable file ???? UNIX
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If the UNIX file does not correspond to any of these types, a differentiation
is solely made between either text or binary data files. A binary data file is
defined as a file where at least 30% of the characters are not contained in the
7-Bit ASCII code. All other files, including empty files, are classified as type
TEXT.

If the user does not have sufficient access privileges to read a particular file,
the file is classified as type “NOPE”.

If a file cannot be read by a particular user because a physical read error has
occurred, the file is classified as type unreadable.

You can also create or modify the file type or creator manually. See Automatic
extension mapping in 5.4 “Public and private volumes” for related information.

Note: If a file type is assigned the code “UNKN/UNIX” the file server automatically
enforces a file type conversion.

If necessary, the generic file types feature can be disabled (see binonly in
9.1 “AFP server preference keys”). In that case all UNIX files are classified as
binary data files (DATA/UNIX).

File and record locking

The EtherShare file server supports file and record locking between Mac
workstations. Likewise, PCShare – a TCP/IP-based Windows networking
product developed by HELIOS – supports file and record locking between
Windows workstations. Locks of both file servers are shared by accessing the
same “locktable” file which is in the “HELIOSDIR/var/run” directory. Hence,
if a volume is shared by both EtherShare and PCShare, cross-platform file and
record locking is enabled.

“afpsrv” supports mandatory locking used by Apple AFP or Windows SMB
clients.
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UNIX advisory locking is not compatible with the mandatory locking method,
and UNIX applications should not manipulate files at times they are in use by
HELIOS AFP or SMB clients.

Symbolic links

Symbolic links allow copying application packages to, or from the server,
without loss of information.

5.3 Users and groups

User and groups are authorized by use of the HELIOS authentication server.
Details on the authentication server can be obtained in the HELIOS Base
manual.

Guest access

Users that are not registered in the system but still need access to the network
from time to time can log on to the file server as a guest. The administrator
can configure EtherShare to either accept or reject guest access.

During logging on, guests are not required to enter user name or password.
Guests only have access to public volumes, and do not have a private volume.
If necessary, guests can be denied access to specific public volumes by suitably
configuring the access privileges of the respective volumes.

Although guest users do not need to enter any user name, guest access must
still be declared in the “Preferences” file via the guest preference (see “Au-
thentication server preference keys” in the HELIOS Base manual), in order to
allow guests group membership.

In order to ensure that guests do not have access to protected applications or
documents of other users, the administrator should assign the guest a primary
group which has no other members. Folders and files are protected against
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access by guests as long as access for the user category “Others” has been
explicitly disabled.

Since user volumes are only available for registered users, a home directory
for guests is ignored by the file server.

5.4 Public and private volumes

A volume (in the Mac file system) can be stored on both a removable disk
or a hard disk. A hard disk can also be subdivided into several volumes, i.e.
several separate file systems. The file system used by Mac computers is called
HFS (Hierarchical File System) or HFS+, respectively.

The UFS (UNIX File System) is able to use storage capacity which is available
through the network remotely in another computer via NFS (Network File
System). Such remote storage can also be used by EtherShare.

On EtherShare, the UNIX file system can be treated like an Apple hard disk:
one or more volumes containing folders and files can be mounted at a particular
UNIX directory and made available to a group of users.

Volumes can be set up by using “prefvalue” (see “HELIOS utility programs”
in the HELIOS Base manual), but we strongly recommend that you do this
with HELIOS Admin instead.

Note: Please see 3.3 “Volume AFP settings” for related information, especially if
you are using file systems mounted remotely through NFS.

Public volumes

When a volume is created, it is automatically available to all users/groups.
Such volumes are called public volumes (even if not all users/groups have
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the right to access them). Public volumes can optionally be protected with a
password.

During the installation the public volume “demovol” is created. The installation
program also creates a volume “HELIOS Applications” in “HELIOSDIR/
public”. It is used for HELIOS tools and user manuals.

If you want to deny guest access to a public volume, set the Guest preference
to FALSE (see “Volume preference keys” in the HELIOS Base manual). No
other configuration changes are necessary.

Private volumes

Each time you log on to EtherShare, if a home directory has been specified,
you are automatically assigned a private “home” volume by the file server. The
name of the home volume is shown abbreviated on the Mac workstation by
using the tilde (“~”) character together with the user name (e.g. “~david”). It
can be used to store the user’s private files.

Deny access to private volumes

If a particular user should only be allowed access to public HELIOS volumes,
and not to a home volume, the Home Directory field in HELIOS Admin can be
left empty when creating the user (which is equivalent to omitting the home
directory entry in the system file “/etc/passwd”). This may – depending on
the UNIX system – disable the login to the UNIX shell, but is not the same as
unchecking Mac Visible in the Volumes:~ window in HELIOS Admin, which
simply makes home volumes invisible to (all) Mac users.

“afpsrv” very extensively checks for overlapping HELIOS volumes during each
mount request. If an already mounted volume does include (or is included
inside) a volume to bemounted, this will be invisible in the Connect To Server...

dialog and an appropriate system error message, which contains the names of
the overlapping directories, will be logged from “desksrv”.
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Please make sure that no single HELIOS volume overlaps any other HELIOS
volume. If in doubt, please consult your HELIOS dealer to implement a safe
volume configuration.

Duplicate volume names

Volume names must be unique. If the user or administrator defines the same
volume name more than once, the entry encountered last during user login is
ignored because no two volumes on the file server can have the same name.
Otherwise, it would not be possible for workstations to uniquely access a
particular volume. The new volume must be given another name.

The administrator should be particularly careful not to create a volume with
the same name as a user’s home volume (e.g. “~rita”), because the user will
then no longer be able to access their home volume any more.

Automatic extension mapping

The file server supports automatic mapping of file name extensions. This
simplifies file sharing between EtherShare, UNIX and PCShare, by simulating
an appropriate Mac type and creator, allowing Mac users to open files created
on Windows or UNIX with a double-click.

Note: This feature allows you to allocate specified file name extensions to applica-
tion or document icons that already reside on the file server, but it does not
allow creating new icons.

Extension mapping can be defined by editing the “suffixes” file or by means
of HELIOS Admin (see “Extension Mappings” in the HELIOS Base manual).
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5.5 Access privileges

Access privileges – on UNIX called “permissions” – define which users are
allowed to work with which folders and files. Access privileges are assigned
by the administrator or the owner of a file or folder.

5.5.1 HFS access privileges (Mac OS 9/AFP 2.2)

On Apple’s HFS (Hierarchical File System), no access limitation mechanisms
are available for individual files, because the concept of user authorization is
not known. A file can only be “locked” (write-protected) to prevent unintended
writing/deleting operations. This attribute, however, can be disabled by any
user at will. Furthermore, write-protection is not available for folders.

In a file server environment, considerably more sophisticated access privi-
lege mechanisms are necessary. Apple’s AFP specification for sharing files
differentiates between four different types of privileges:

Read only

This attribute specifies whether a particular folder is visible to the
user. If a particular file is visible it can also be read.

Read & Write

This attribute additionally allows modifications applied to the files
in the folder.

Write only (Drop Box)

This attribute allows only files being “dropped” into a specific
folder.

No access

Any form of access to that folder is denied; neither reading the in-
cluded files, nor applying changes to them is possible. See Fig. 5.4.
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Individual file permissions:

UNIX file system permissions

Read and/or write permissions can be set for the file owner, group members,
and others.

AFP 2.2 access privileges

Historically, using AFP 2.2 to access server volumes, it was not possible to
specify different access privileges for individual files in the same folder. This is
still true for Mac OS 8/9 clients, which use AFP 2.2. If it is necessary to allow
a user to change a particular file, but not change another file, the two files need
be stored in separate folders. If this is not possible, your only choice is to use
the “dt chmod” (see HELIOS Base manual) command to change the privileges
for individual files on the server. While AFP 2.2 does not allow granular
control of access rights, it does facilitate file sharing and collaboration.

HELIOS AFP smart permissions active (default)

Using HELIOS AFP smart permissions, files saved to the server inherit the
permissions of the parent folder. This is the preferred option for workgroup file
sharing. When this option is active, the Finder of OS X clients is not allowed
to change access privileges for individual files. However, changing access
modes from the Finder can be toggled on/off as described below.

HELIOS AFP UNIX permissions

If “smart permissions” are not active, server volumes will use UNIX permis-
sions. UNIX command line utilities in AFP volumes will create files according
to “umask” and work as expected. However, many OS X GUI applications
create all new files and directories with default permissions of:

m Read/write for the owner

m Read-only for the group and others

So “UNIX permissions” have the advantage to be changed in an easier way but
the disadvantage of default permissions that are not optimal for file sharing
and collaboration.
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Extreme care should be taken when changing access privileges of AFP files on
the UNIX server directly (do not forget the resource part). Or, in order to avoid
such problems, use the “dt chmod” program. Incompatible combinations of
privileges could lead to EtherShare access problems, e.g. no read or write
access to a file anymore, or it may no longer be possible to use a folder.

5.5.2 EtherShare privileges (OS X)

Note: This description only applies to OS X clients up to 10.4.
OS X 10.6 clients and later can use the HELIOS Permissions tool to change
server file permissions in the Finder of connected Mac workstations.
See 8.1 “HELIOS Permissions”.

OS X is a UNIX-based operating system, so AFP file/directory access permis-
sions are identical to the UNIX permissions. However, HELIOS AFP 3.1 and
newer supports two (mutually exclusive, serverwide) permission modes for
saving files and folders: HELIOS AFP smart permissions and UNIX permis-
sions. As mentioned above, the default setting is to use smart permissions, so
that files saved to the server will inherit the permissions of the parent folder.
When smart permissions are turned off, standard UNIX permissions will be
used when saving files and folders. See checkbox AFP UNIX Permissions in the
HELIOS Admin volume configuration window (Fig. 3.3) and the useunixperm

volume preference in the HELIOS Base manual.

Change access modes from the Finder

With enabled UNIX permissions, permissions can be changed using the “Get
Info” dialog from the OS X Finder as usual.

With disabled UNIX permissions, which is the default, permissions cannot
be changed directly. This feature is only available with active UNIX permis-
sions. However, to allow an authorized user to change the permissions, do the
following:
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â Open the Finder’s “Get Info” dialog for a file/folder in the server volume.
Then open the permission details, enter the new user name unixperm and
press the TAB key.

A Finder message pops up (“invalid user name”), together with the following
AFP message (Fig. 5.1):

Fig. 5.1: Enable UNIX permissions

Now the UNIX permissions are enabled for the AFP server client process,
irrespective of the volumes’ smart permissions status, so you can change the
permissions as required. The owner can change the read/write mode within
the Finder for owner, group and others.

Note: AFP 2.2 allows the owner of directories to transfer the ownership to a
different user. AFP 3.1 and newer does not support changing the owner
unless you are the user “root”.

The UNIX permissions for the particular client are enabled until the client
disconnects from all server volumes or the UNIX permissions are switched
off. Switching off the UNIX permissions is done by entering the user name
reset in the Get Info dialog, followed by pressing the TAB key. Then again, a
Finder error (“invalid user name“) pops up, together with the following AFP
message (Fig. 5.2):
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Fig. 5.2: Reset permissions to volume default

Create new folders on UNIX

As discussed earlier, a folder in a volume is represented as a directory in the
UNIX file system, which is also associated with a (usually invisible) resource
directory. The EtherShare file server uses the resource directory to store the
Mac’s resource fork and the Finder info for the files. If it is required to create
a folder directly from UNIX use the “dt mkdir” program, so both the main
and the resource directory will be created. The “dt chown” and “dt chgrp”
commands are used to set the owner and group of the folder.

The “dt chmod” command sets appropriate access privileges:

$ dt mkdir Folder
$ ls -ld Folder Folder/.rsrc/
drwxrwsr-x 3 root root 512 Jul 20 16:01 Folder
drwxrwsrwx 2 root root 512 Jul 20 16:01 Folder/.rsrc/

Please refer to the UNIX system documentation for more details of the “mkdir”,
“chown”, “chgrp”, “chmod”, and “ls” commands. Also refer to the “dt mkdir”,
“dt chown”, “dt chgrp”, “dt chmod”, and “dt ls” commands in the HELIOS
Base manual, respectively.

We recommend that network folders are always created by using the Mac
Finder, in the same way as local folders. This guarantees that all of the above
considerations are handled automatically.
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Delete folders

A folder can be deleted in an analogous way by using the UNIX command dt

rm -r, provided that the user has sufficient privileges. If the folder contains
further folders and/or files, these are also deleted.

Create new volumes on UNIX

IBM and Sun operating systems set or clear the “setgid” bit on directories to
indicate whether files created in that directory should follow BSD semantics
or System V semantics, respectively. The “setgid” bit is then automatically
propagated to nested directories. Mac users expect the BSD style, thus HELIOS
Admin ensures that the “setgid” bit is set if it creates a directory for a new
volume or a new user. The “dt” utility will automatically make sure that the
“setgid” bit is set.

5.5.3 EtherShare privileges (Mac OS 8/9)

The four modes of privileges are separately defined for four categories of AFP
users: the owner of the folder (“Owner:”), group members (“User/Group:”),
all other users of the system (“Everyone”, equivalent to “Other” on UNIX),
and the administrator. This allows access privileges to be individually tailored.
With the exception of the administrator, the owner of a folder is the only one
who is allowed to change the privileges of the folder (if necessary, you can
allow “Owner:” to be any user, by just leaving the field blank).

Read & Write

The folder is visible and all files can be read, changed and deleted. New files
and folders can be created.

Read only

The folder is visible and all files can be read. Amendment or deleting of files
is not allowed. New files and folders cannot be created.
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Write only

The directory content is not visible and files in the folder cannot be read,
amended or deleted. However, new files and folders can still be created since
the folder acts as a drop folder (Drop Box).

None

Access to the files and folders is not possible. New files and folders cannot be
created and the folder cannot be deleted.

Correlation to UNIX access privileges

The following table shows the four combinations of access privileges for the
EtherShare file server, and the corresponding rights in the UNIX file system.
Remember that the files that are stored in the folders have always the same
access privileges as the folders themselves:

EtherShare file server UNIX file system
Read & Write (rw-) read write execute
Read only (r--) read execute
Write only (Drop Box) (-w-) write
None (---)

Note: The System V UNIX semantics use “x” on directories, whereas “s” provides
an additional bit in BSD UNIX for setting group IDs. For more detailed
information see also Create new volumes on UNIX above. You may also
refer to your UNIX documentation.

The Finder’s sharing section (in File > Get Info > Sharing...) can be used
to display and edit the access privileges. Fig. 5.3 shows the privileges for a
folder.
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Fig. 5.3: Folder access privileges

The corresponding directory listing for this folder, made with the UNIX pro-
gram ls is:

$ ls -ld adi adi/.rsrc
drwxrws--- 3 hendrik helios 512 Jul 20 16:16 adi
drwxrws--- 2 hendrik helios 512 Jul 20 16:16 adi/.rsrc/

Only the folder’s owner or the system administrator (“root”) can change the
access privileges of the folder. The corresponding fields and checkboxes are
grayed out when another user asks for privileges information (Fig. 5.4).
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Fig. 5.4: Access privileges for user not being the owner

5.5.4 Creating a drop box

HELIOS supports the idea of drop boxes for folders with mode “733” (others
and the group can drop files/folders) or “773” (only others can drop files/
folders). The dropped files and folders will have read/write permissions and
can be opened by the folder owner or folder group members only. This feature
is active for volumes with smart permissions enabled.

A drop folder can be created using the “dt mkdir” command, e.g.:

# dt mkdir -m 733 dropfolder
# dt chmod g+s dropfolder
# dt chown michael dropfolder
# dt chgrp adminusers dropfolder
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The folder list will look like this:

# dt ls -l
drwx-ws-wx 4 michael adminusers 136 Mar 13 08:25 dropfolder

The chmod g+s command enforces that files/folders created within this folder
will inherit the group “adminusers” from the drop folder.

5.6 EtherShare compatibility notes

When compared to the Apple file server using HFS, EtherShare has a few
minor limitations but also offers powerful additional features which result in
part from specific features of the UNIX environment on which EtherShare is
based.

Case-sensitivity

The following table compares the behavior of different operating systems
regarding the file name case sensitivity.

Preserve Ignore

OS X (HFS default) + +

OS X (UFS/Xsan) + –
Mac OS 8/9 + +

Windows + +

UNIX + –
MS-DOS – +

Table 5.1: Operating systems and the case-sensitivity of file names

As Table 5.1 shows, there is no case preserving on MS-DOS, i.e. file names
entered in lowercase will appear uppercase in the directory listing. In contrast
to UNIX, the Mac and Windows operating systems are not case-sensitive when
looking for files or creating or opening them. If your application looks for
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“Dave”, they will also find “dave”, and you cannot create a file “Dave” and a
file “dave” in the same folder in a local volume. Due to its UNIX heritage, this
is not true for HELIOS volumes. This distinction is normally not a problem –
if an application has created a file called e.g. “Editor Prefs” and needs to open
this file again, it usually tries to open it using the same name and not “EDITOR
PREFS”. If an application cannot find a file which it has created, and the
file is visible on UNIX and in the Finder, it is likely that case-sensitivity is to
blame. If you are able to determine the name of the file which the application
is trying to open, you can often provide a workaround by using a Mac Alias or
by renaming the file. Contact your application vendor for assistance.

ASCII “0”

A file system error is issued if files whose names contain ASCII “0” (zero)
are copied to the server or if application programs or tools try to create such
files. This restriction also applies to all AFP compatible file server products
(including those from Apple).

5.7 Time Machine

HELIOS EtherShare in combination with the OS X built-in “Time Machine”
feature enables backups of networked Mac workstations and laptops. Ether-
Share AFP volumes can be used as backup disks for Time Machine backups
from OS X.

Backed-up data is accessible from anywhere within the local network and can
easily be restored by Mac users. Enabling HELIOS EtherShare support for
“Time Machine Backup” takes less than a minute and requires no additional
software installation. Even the restoration of a crashed Mac or the transfer of
a saved system to a new Mac is supported directly from the OS X install DVD,
or with the Mac “Migration Assistant”.
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Entire Mac networks can do Time Machine backups to a central HELIOS
server volume. The main advantages of the HELIOS server support for Time
Machine backups are:

• Automatic hourly, daily and weekly backups, with no configuration required
• Easy restore by users using the Time Machine Finder interface
• Optimized automated backups of mobile MacBooks (Time Machine keeps
track of any files changed since the last backup)

• Mac backups are stored as HFS disk images on the server (no trouble with
millions of files)

• No client software installation required
• Excellent backup performance
• Easy and fast Mac recovery by users
• Central client backup repository, which in turn is backed up as part of the
server backup plan

• Disaster recovery from the OS X install DVD or recovery partition

Server setup

In general, a dedicated EtherShare volume should be created to use as a backup
disk for Time Machine backups. Use HELIOS Admin to enable Time Machine

Backup (see Fig. 5.5) in the volume configuration. This enables the volume to
be selected in the Time Machine preferences. In addition, you should activate
the AFP UNIX Permissions checkbox, to enforce security so that one user cannot
access backups from other users.
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Fig. 5.5: HELIOS Admin – Volume configuration
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6 The EtherShare print server

This chapter describes the EtherShare print services via HELIOS TCP. For
possible print server (output) interfaces refer to chapter “The HELIOS printing
system” in the HELIOS Base manual.

A suitable configuration allows any combination of input and output options.

6.1 The print server programs

papsrv

“papsrv” is the program that implements network communication functionality
for the print server. TCP is used for the communication with most types of
printers and print servers, or via HELIOS TCP printing (see 6.3 “HELIOS
TCP Printer”). Once started, “papsrv” continuously monitors the network for
printing requests. When a print job is received, it is first stored in the host file
system before being passed to the HELIOS “lpr” program, which transfers the
job to “lpd”. The latter calls the appropriate interface program (“tcpif”, etc.)
and the optional output filter (“psof”). The interface program then passes the
job to the printer.

6.2 The print server in operation

Each print job consists of the print data itself and one or more so-called “prep”
files (PostScript print procedures and dictionaries, also called “control files”
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or “inits”), which precede the print data. It may also be necessary to download
fonts and a banner page to the printer.

The originator of the print job (the application’s printer driver in the worksta-
tion) communicates automatically with the print server, to agree which “prep”
files must be sent to the printer before printing can start. After being sent by
the workstation for the first time, “prep” files are copied automatically by the
print server to the so-called “prep directory” (“HELIOSDIR/var/spool/dicts”).
This is called “dictionary caching”.

If they are needed again, the “prep” files can be sent from the UNIX host
directly, rather than from the workstation. This reduces network loading and
increases throughput. See 6.5 “Adobe Document Structuring Conventions” for
related information.

Font including (Mac OS 9 clients only!)

Fonts required by a particular print job which are usually not supported by the
printer (downloaded PostScript fonts) must also be included in each job before
sending it to the printer. In order to let the print server know which fonts to
send, those fonts that are permanently available on each printer (resident fonts)
are specified in the “FONTS” file (usually “var/spool/qmeta/<printername>/
FONTS”).

Furthermore, HELIOS Admin can install Adobe “Type 1” and “Type 3” printer
fonts (not screen fonts or TrueType fonts) directly from the font manufacturer’s
original font disk into a central font directory on the host (“HELIOSDIR/var/
spool/psfonts”). The print server only sends those fonts to the printer that are
not already resident. Missing fonts are sent preferentially from the central font
directory, and are not requested from the originating workstation. This reduces
network load, increases throughput and allows the central administration of
printer fonts.

The printer’s resident font list is created automatically by interrogating the
printer when you install a new printer with the HELIOS Admin program. The
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list must be updated (with Update Fonts in the HELIOS Admin Printer menu)
if new fonts have been installed on the printer.

If your printer is not fully LaserWriter compatible, and font interrogation does
not work, a standard font list is supplied automatically. For “Remote LPR”
printers, the copying is done automatically if you set them up with HELIOS
Admin. The “FONTS” file may subsequently need manual editing if your
printer’s font selection is different from those of the Apple printers.

As soon as “papsrv” has received and spooled the entire print job, the job
is passed to the host system program “lpr”. “lpr” then queues it and passes
control to “lpd”. “lpd” is responsible for passing the job to the output filter
“psof” and to the specified interface program, such as “tcpif”, which makes
the connection to the printer itself: “lpd” determines how the printer is con-
nected to the server by examining the entry for the printer in the system file
“HELIOSDIR/var/conf/printcap”. This printer configuration file also speci-
fies (with the “sh” suppress headers flag) whether a title page (“banner”) is
required.

The specified interface program includes the needed fonts, resolves any refer-
ences to external images if you have HELIOS ImageServer installed, resolves
“%%Include. . . ” references (see 6.5 “Adobe Document Structuring Conven-
tions”), transfers the job to the printer, and waits for messages that may be
returned. It is also responsible for interrogating the printer’s page count before
and after the job.

If an error message is returned, it is sent to the user by the UNIX system pro-
gram “mail”. Read also about mail and clientmessages and User and document
names in print jobs for related information (see HELIOS Base manual).

Several types of error messages, e.g. “out of paper” or “paper jam” are also
sent to the program “syslogd”, which can be configured by the administrator
(in “/etc/syslog.conf”) to specify the route that the message then takes (e.g.
output to console). This allows rapid response to those error conditions that
demand immediate attention.
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If the print server detects that the printer has refused the print job completely,
e.g. due to a syntax error in the PostScript code, the rest of the job is immedi-
ately aborted with an appropriate error message and, depending on the settings
in HELIOS Admin, e.g. forwarded to an error queue.

Since print jobs are temporarily stored in the server file system, they can be
rapidly transmitted from the workstation to the host without the workstation
having to wait for the printer (spooling function). Further processing of each
print job is carried out automatically by the print server, while the user can
continue with other jobs.

As described above, the print server stores all “prep” files in the “prep directory”
and only transfers them to the printer when they are required. The “prep” files
are not made resident on the printer. This allows switching between different
incompatible “prep” files, without having to manually reset the printer. The
print server appends the “prep” files in non-resident form to the beginning of
the print job, and sends the complete file to the printer as a single job.

Restarting the print server

If the server shuts down while print jobs are running, you will need to restart
the affected printers using the lpc restart all command. This can also be
done with the Restart Queue option in the HELIOS Admin Printer menu.

restart-pap

The shell script “HELIOSDIR/sbin/restart-pap” is used internally by Ether-
Share to reconfigure all printer queues. This is necessary to enable printer
configuration changes in the “Preferences” file to come into effect immediately.
See 7.1 “restart-pap”.

Note: “restart-pap” just notifies “papsrv” to refresh its configuration. The same
can be achieved via:
“HELIOSDIR/bin/srvutil reconf papsrv”



6.3 HELIOS TCP Printer 53

6.3 HELIOS TCP Printer

The HELIOS TCP printer driver is the preferred method to print jobs from
OS X clients to the EtherShare spooler. The benefit is that the HELIOS TCP
printer driver will synchronize the PPD during the printer queue setup, it
registers printer queues via Bonjour for easy browsing, and it handles job sizes
larger than 4 GByte. Alternatively, print jobs can be spooled via Remote LPR
which is supported by HELIOS Base. For Mac clients, it is recommended
to use the HELIOS TCP printer driver clients, which is supported by OS X
clients and allows easy printer browsing via Bonjour.

6.3.1 Client configuration

â Mount the “HELIOSApplications” volume and openMacOS > EtherShare
Tools > HELIOS TCP Printer.

â Double-click the “HELIOSTCPPrinter.pkg” icon.

â Authenticate, click OK and follow the instructions until the installer has
successfully installed the software.

6.3.2 Create a new printer

â In the OS X “System Preferences” open the printer configuration and click
on the icon in the menu list (see arrow in Fig. 6.1).
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Fig. 6.1: Apple “Printers & Scanners” system preferences

â Select a “HELIOS TCP” printer queue and confirm your selection with
the Add button (see Fig. 6.2).

Printers that are not visible via Bonjour, e.g on remote networks can be con-
figured in “/Library/Preferences/de.helios.tcpprint.conf”. Entries in this file
are of the form host:printer or host:printer:port. All printer configured in
this file are listed in the “Add Printer” dialog (see Fig. 6.2).

The “HELIOS TCP Printer” is now available in the printers list in the system
preferences and is ready to use.
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Fig. 6.2: Select printer queue for “HELIOS TCP Printer” (OS X)

6.3.3 Synchronize PPDs

â In case the server PPD is changed at a later date, just remove the printer
and create it anew, according to the steps described before.

The changed server PPD will then be used for the queue.
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6.3.4 Remove the printing plug-ins

During the installation of the HELIOS TCP/IP printer the following files are
created on the client:

File location Function
/Library/Printers/PPDs/Contents/Resources/HELIOSTCP.ppd PPD file
/usr/libexec/cups/backend/heliostcp “CUPS” compatible

printer driver for
communication with
“papsrv”

Table 6.1: Files created on the client

â To remove the HELIOS TCP/IP printer just delete the TCP printer queue(s)
from the Apple “Print & Fax” system preferences, then the files listed in
the table above.

6.4 Configure printers manually

Note: Generally, it is more convenient and safer to set up printers with the HELIOS
Admin program.

If more than one printer queue is serviced by the print server, a separate
“papsrv” process must be configured for each of them.

The program “papsrv”, which implements TCP printing functions for the net-
work, has noway of knowing how each printer is physically connected. All com-
munication with the printer is coordinated through the HELIOS program “lpd”,
which extracts information about the printer from “HELIOSDIR/var/conf/printcap”,
using the logical (UNIX) printer name received from “papsrv” as the key. “lpd”
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then routes the job through the output filter program “psof” (to generate an
optional banner page) and sends it to the appropriate interface program (“tcpif”,
etc.).

Each printer queue requires an entry in the “printcap” file to describe in detail
the way in which the associated physical printer is connected.

The entry in the “printcap” file specifies which interface program and output
filter program are required. The output filter is used to print a banner page,
and the interface program implements the connection to the physical printer.
The output filter for all PostScript printers is the “psof” program.

6.5 Adobe Document Structuring Conventions

The HELIOS print server system has been designed to meet Adobe’s DSC
(Document Structuring Conventions). The following paragraphs describe
some of the more important features. Please refer to Adobe’s “Guidelines for
a Distributed Printing Environment” for more details.

“ProcSet queries” are handled as follows by the print server program “papsrv”:

“procsets” sent by a Mac application with a print job are captured automatically
by “papsrv” and stored in “HELIOSDIR/var/spool/dicts” with a name similar
to the original “procset” name. If a following application needs the same
“procset”, it is sent from the “dicts” directory rather than transferring it again
from the Mac to the print server via the network.

Certain PostScript comments are recognized and reacted on by the EtherShare
printer interface programs as follows:

%%IncludeProcSet
%%IncludeResource: procset
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If possible, the specified procset will be included in the print job from the
“HELIOSDIR/var/spool/dicts” directory. Otherwise you will get a warning.

%%DocumentProcSets
%%DocumentNeededProcSets
%%DocumentNeededResources: procset

All procsets needed – but not supplied – by the document will be included
from the “HELIOSDIR/var/spool/dicts” directory in the print job.

%%IncludeFont (obligatory includes)
%%IncludeResource: font

If possible, the specified font will be included in the print job from the
“HELIOSDIR/var/spool/psfonts” directory, which contains downloaded Post-
Script fonts that have been installed there manually with HELIOS Admin.

%%DocumentFonts
%%DocumentNeededFonts
%%DocumentNeededResources: font

All fonts needed by the document that are not resident on the printer are in-
cluded with the print job: The print server checks the corresponding printer res-
ident font list “HELIOSDIR/var/spool/qmeta/<printername>/FONTS”. This
file can be updated using HELIOS Admin if you install new resident fonts
on your printer. In case the resident font list cannot be determined, the font
information from the chosen PPD is used instead.

In case a requested font cannot be included, the respective interface program
sends an error message to the user via “srvmsg”. Users can additionally receive
the message on their workstation via e-mail.

%%IncludeFile
%%IncludeResource: file
%%IncludeDocument

If possible, the specified file (e.g. an EPS picture) will be included in the print
job. The file can be specified with either UNIX or Mac file and path name
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conventions. In the latter case, the print server determines the corresponding
UNIX directory by inspecting the “Preferences” file for valid AFP volumes.

%%IncludeFeature

If possible, the specified feature from the printer queue’s PPD file will be
included in the print job. The printer interface program accepts messages from
each printer while printing. The messages are checked for errors, which are
forwarded to the originating user.

EtherShare’s automatic font downloader also supports all programs that print
PostScript containing “Adobe Document Structuring” comments. TrueType
fonts are passed transparently from the Mac to the printer through the print
server but cannot be installed in the font downloader.

Linotype Color Separation Extensions

The print server also supports “Linotype Color Separation Extensions” –
the print server interface programs act as an ICS (Included Color Separa-
tion) includer. A special PostScript dictionary “LinoDict 1.0” is provided in
“HELIOSDIR/var/spool/dicts” for this purpose. This functionality can also
co-exist with the ImageServer option without conflict. Please contact HELIOS
if you need more details.
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7 EtherShare utility programs

7.1 restart-pap

The shell script “HELIOSDIR/sbin/restart-pap” is used internally by Ether-
Share to enable – via “srvutil” (see the HELIOS Base manual) – printer
configuration changes to come into effect immediately, without restarting the
entire HELIOS system.

7.2 rmtrash

The “rmtrash” command allows emptying a particular network trash can that
is specified with the <path_to_volume> parameter.

Note: You should be logged-in as “root” when calling “rmtrash” from the command
line, and the volume should not be mounted.

“rmtrash” can also be called from HELIOS Admin, with the respective volume
highlighted in the Volumes list and then choosing Empty Trash... from the
Volume menu. This method is recommended.

Usage:
rmtrash [-f] <path_to_volume>
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7.2.1 Option

-f Deletes the whole “Network Trash Folder” in the volume. With
-f not specified, only the files in the “Network Trash Folder” are
deleted.

Example:
# cd /usr/local/helios
# sbin/rmtrash /home/macuser
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8 EtherShare client applications

8.1 HELIOS Permissions

The HELIOS Permissions tool allows changing the server file and folder
permissions in the Finder of a connected Mac workstation. This omits the
need to do it directly on the server via command line.

Users with administrative rights can also change owner and groups for files
and folders and their permissions. Creating “Drop Folders” and recursive
permissions changes are also supported (see pop-up menu in Fig. 8.2).

Note: Since it handles UNIX permissions, the HELIOS Permissions tool only works
with UNIX-based servers. It supports files and folders in HELIOS volumes.
When editing local files you will receive an error message (“Some items
were skipped”).

8.1.1 Features

Regular users

Apart from their own files, users cannot change owner or groups of a file or
folder, or their permissions. This is only possible for “root” or members of the
“SysAdm” group.

However, users can change the group membership of a file or folder they own
to any group they are member of.
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“root” and members of the “SysAdm” group

In addition to the owner and mode settings, “root” and members of the
“SysAdm” group can also change the group membership of a file or folder to
any existing group.

8.1.2 Installation

â Mount the “HELIOS Applications” volume and open “MacOS > Ether-
Share Tools”.

â Open the “HELIOS Permissions” folder, double-click the “HELIOS Per-
missions.pkg” package file and follow the instructions for installation.

The HELIOS Permissions tool (“HELIOS Permissions.service”) gets installed
in “/Library/Services”.

8.1.3 Usage

Inspect and change permissions

â To inspect the permissions of a server file right-click on the name and
select Services > HELIOS Permissions.

A window displays the permissions for the owner and the group as well as for
everyone (see Fig. 8.1). Changes become active immediately.

â Select the desired permissions from the corresponding pop-up menu.

Change owner or group

â To change the owner of a file or folder type the new owner name into the
text field.

â Press the TAB or RETURN key to apply the changes.
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Fig. 8.1: HELIOS Permissions

â To change the group of a file or folder select the group name from the
pop-up menu.

If it is a folder, the window contains the additional menu (see Fig. 8.2).

â Choose Apply Drop Folder permissions if you wish to make the selected
folder a “drop folder”. A drop folder merely allows moving or copying
items into it but does not provide read or write permissions (except for the
owner of the drop folder).

Instead of using the Apply Drop Folder permissions option, you can assign
drop folder permissions for “Group” or “Everyone” individually by selecting
Write only (Drop Box) from the pop-up menu.
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Fig. 8.2: Additional options for folders

â Select Apply to enclosed items... if you wish to apply the folder privileges
to all files and subfolders within this folder (see Fig. 8.3).

If the selected folder contains many objects, this can take quite some time.

Note: You must be allowed to make changes on a folder. Otherwise the menu
is not available in the permissions window.

Fig. 8.3: Apply permissions to enclosed items
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8.2 HELIOS TCP Printer driver

The HELIOS TCP Printer driver is described in 6.3 “HELIOS TCP Printer”.

8.3 HELIOS Admin application

The HELIOS Admin application is described in 3 “HELIOS Admin”.

8.4 The HELIOS Meta plug-in

The “HELIOS Meta” plug-in allows OS X users to add and edit file comments
for files and folders residing on mounted HELIOS volumes. These comments
work cross-platform, i.e. they can also be added and edited:

m from Mac OS 9 clients

m from any web client, directly in a HELIOS WebShare sharepoint

m fromWindows clients via the “HELIOSMeta” feature in HELIOS PCShare

OS By HELIOS Meta plug-in By operating system
Mac OS 9 +

OS X +

Table 8.1: OS and file comments management
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8.4.1 Installation

â Mount the “HELIOS Applications” volume and open “MacOS > Ether-
Share Tools”.

â Open the “HELIOS Meta” folder, double-click the “HELIOS Meta.pkg”
package file and follow the instructions in the installation menu.

The plug-in is installed as “HELIOS Meta.service” in “/Library/Services”.

â Log out from OS X and log in again.

The “HELIOS Meta” plug-in is now ready to use.

8.4.2 Adding, viewing, and editing file comments from within
OS X

â To add a file comment to a file or folder, right-click on the file or folder
name and select the Edit comment or Services > Edit comment item from
the pop-up menu.

â In the “HELIOS Meta” window highlight the file or folder that you wish
to add a comment to, make a double-click in the “Comment” column
(Fig. 8.4) and enter your comment. Then click with the mouse outside the
editable field, e.g. on the file name, and close the dialog window. In the
same way, existing comments can be edited.

Fig. 8.4: File comment in OS X
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8.4.3 Adding, viewing, and editing file comments from within
Mac OS 9

â In the Mac OS 9 Finder highlight the desired file or folder and open “File
> Get Info > General Information” to edit the comment.

8.5 HELIOS LanTest

HELIOS LanTest is a tool for testing and measuring the performance of file
system and print system services. It offers detailed evaluations for file and
record locking on file server volumes, as well as for many typical file system
operations. LanTest results can be used to find bottlenecks, for troubleshooting,
or just for maintenance purposes.

Mac Finder copy block size

The Mac automatically increases the Finder copy read/write block size up to
several megabytes, until there is no additional performance gain, and continues
with the most stable performance. This is a dynamic process. HELIOS LanTest
uses a static block size during the entire test depending on the selected network
speed, e.g. for Gigabit networks it uses 128 kByte buffers (see Table 8.2).
The HELIOS LanTest approach is more realistic because no application uses
a dynamic adjustment and there is no API doing so automatically. Another
reason is that HELIOS LanTest should measure the network performance
and the server latency and doing super large block sizes would not include
the server latency. Network and server may be capable to offer additional
performance when multiple threads are reading/writing in parallel and when
super large blocks are being used. However, this is not realistic because it
causes drawdowns on slower network connections and limited network switch
buffering as well as limited socket I/O buffers on the server and client.
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Network Block size Test file

Slow networks, e.g. Standard Ethernet/DSL 32 kBytes 3 MB
Fast networks, e.g. Fast Ethernet 64 kBytes 30 MB
Very fast networks, e.g. Gigabit Ethernet 128 kBytes 300 MB
Enterprise networks, e.g. 10 Gigabit Ethernet 1024 kBytes 3000 MB
Backbone networks, e.g. 40 Gigabit Ethernet 4096 kBytes 12000 MB

Table 8.2: Block sizes used in HELIOS LanTest

Fig. 8.5: HELIOS LanTest dialog
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The HELIOS LanTest tool is available in the “HELIOS Applications” volume
in MacOS > EtherShare Tools > HELIOS LanTest.

â Double click “HELIOS LanTest.dmg” and copy the “HELIOS LanTest.app”
to your Mac.

â Start HELIOS LanTest (Fig. 8.5). From the File menu select Choose Test

Volume... and click the Choose button.

â Next, click on the Network pop-up menu, and select the network type you
are connected to (Fig. 8.6). Depending on the network specified in this
window, LanTest determines the test load, i.e. the size of test files that are
processed at a time.

This makes sense because Fast Ethernet (100 Mbit/s) networks have a higher
data throughput than the standard Ethernet (10 Mbit/s). Gigabit Ethernet
reaches a data throughput of up to 1 Gbit/s (1000 Mbit/s), 10 Gigabit Ethernet
up to 10 Gbit/s (10000 Mbit/s), and 40 Gigabit Ethernet up to 40 Gbit/s (40000
Mbit/s).

Fig. 8.6: Other settings dialog

8.6 HELIOS Spotlight search

Spotlight searches range from simple queries to complex combinations of
attributes. Search options may include Boolean logic (and/or/not), quoted
phrases, keywords and values, and range support. For details refer to the
HELIOS Index Server user manual.
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9 Preferences

This chapter lists all the preferences that are pertinent to EtherShare. Find a
description of how to set, view, change or delete preferences, with the HELIOS
utility programs “prefdump”, “prefvalue”, and “prefrestore”, in the HELIOS
Base manual.

Important: Make sure that preference keys DO NOT start or end with a slash (“/”)
character, and note that they are case-sensitive! Also, if any preference key
or preference value includes spaces, that key or value must be enclosed in
quotes.

9.1 AFP server preference keys

The following keys require a restart (see “srvutil” in the HELIOS Base manual) of
the service to take effect:

Key: Programs/afpsrv/<preference>

afp3 bool TRUE

This preference allows disabling the AFP 3.3 features for OS X
clients. Setting it to FALSE causes the server to connect OS X clients
via the AFP 2.2 protocol version.

dhx128uam bool TRUE

This preference allows using dhx128 encrypted passwords on login.

dhx2uam bool TRUE

This preference allows using DHX2 encrypted passwords on login.
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dhx2PrimeBits int 512

The login security number of bits, the minimum value is 512, more
than 128 is secure.

cleartextuam bool TRUE

This preference allows using clear text passwords on login. For
Mac OS 7/8 compatibility reasons, the default is TRUE which means
that these Mac clients will be able to log on to the server.

allowchangepasswd bool TRUE

If set to FALSE, the Change Password... option in the Mac Connect To

Server... dialog will not be available. If the authentication server
uses authentication against a system that does not support chang-
ing passwords, PDC or LDAP, this preference will automatically
change to FALSE.

directorycache int 64

This preference determines how many directories are cached by
“afpsrv” at a maximum. In volumes containing many directories,
each containing few files, it can be advisable to increase this value.
If the machine is fitted with little memory, and the volume contains
fewer directories, each with a high number of files, a smaller value
reduces the memory requirement of “afpsrv”.

enableguest bool FALSE

If set to TRUE, the “Guest” option in the Mac Connect To Server...

dialog becomes available. Otherwise it will appear grayed out and
cannot be selected.

dnsSrvName str ""

Allows specifying a fully qualified DNS name for the server, e.g.
<hostname.yourdomain.com>.
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inheritowner bool FALSE

By default, new files and folders which were created via AFP will
keep the ownership of the user who created it. As AFP 2.2 for
Mac OS 8/9 clients does not support individual file permissions,
changing this preference to TRUE brings back the EtherShare 2.6/3.1
behavior which inherits the file owner from its parent directory.
TRUE/FALSE will only affect AFP 2.2 and AFP 3.1 and newer vol-
umes with disabled useunixperm preference (see “Preferences” in
the HELIOS Base manual).

locks int see description

Specifies the number of “file and region locks” that the server
allows simultaneously (if PCShare is installed on the same server
it must be allocated the same settings).
The default for this parameter is sessions*(files+20), where “ses-
sions” is equal to the number of units (clients) for which you bought
your license and “files” is the maximum number of of files (see
files preference).
Do not set this preference to an unnecessarily high value because
this would increase HELIOS Services’ requirement for UNIX sys-
tem resources.

sessions int (see description)

Specifies the maximum number of workstations (clients) that are
permitted to work on the file server simultaneously. This value
should normally be the same as the total number of Mac worksta-
tions that are connected to the AFP server. The value you choose
should be less than or equal to the number of sessions allowed by
your software license. The maximum tolerable number of work-
stations depends on the type of Mac applications you mostly use
(whether they are file-intensive or client-server applications), on
the configuration of your server system, and on its expansion stage.
The default value for sessions is the number of sessions allowed
by your software license.
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useindex bool TRUE

Allows the Spotlight search for text document content and image
metadata.
Keep in mind that this preference has a server-wide effect so that
every AFP volume on the server supports the HELIOS index server
search.

hidedotfiles bool FALSE

Files which start with a dot (“.”) in their file name are marked to
be “hidden” for all volumes on connected clients.

files int 512

This preference specifies the maximum number of files that can be
opened by one file server process simultaneously. The achievable
maximum cannot exceed the maximum number of open files per
process currently allowed by the host. To save system resources, do
not set this value larger than set by the “ulimit” UNIX command.

suffixes str "var/conf/suffixes"

“afpsrv” normally simulates Finder info (such as file type and
creator) automatically for files without Mac resource. The file type
is determined by inspecting the file’s contents. This allows about
20 different icons to be shown for non-Mac files.
In the case of files created by Windows applications, the file type is
typically indicated by adding a suffix to the file name, the so-called
file name “extension”. For example, DOS executable programs
have the extension “.COM” or “.EXE” and DOS batch files have
the extension “.BAT”. Under EtherShare, suitable icons can be
displayed for such files by specifying them in the extensionmapping
table. This is particularly useful in the case of Mac applications
which are able to directly read documents created by the MS-DOS
version without prior conversion. This preference allows you to
specify the location and name of the extension mapping table.
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binonly bool FALSE

“afpsrv” normally simulates Finder info (such as file type and
creator) automatically for files without Mac resource. The type
of file is determined by inspecting the file’s contents. This allows
about 20 different icons to be shown for non-Mac files. Set binonly
to TRUE if this feature is not required. This will prevent the AFP
server from reading the header of each non-Mac file to determine
its document type, in which case all non-Mac files will be treated
as type DATA/UNIX. This means that UNIX text files will then
become invisible to most Mac text editors.

minpwlen int 0

The login dialog in Connect to Server... accepts passwords of
any length from 0 byte to max. 8 bytes. Short passwords may
represent a security risk. A password of zero length is equivalent
to no password. Specify minpwlen as a numeric value between 0
and 8. To improve security, a meaningful minimum value for this
preference is 5.

savepasswd bool TRUE

As a time-saving feature when logging on, the Connect to Server...

dialog on the Mac lets you save your file server user name and/or
user password on the Mac’s local hard disk.
To improve security, set this flag to FALSE to disable the saving of
user passwords in this way, in which case all users have to enter
their password manually each time they log on to EtherShare.

Note: This preference has only effect for Mac clients prior to OS X.

findercache int 16384

The file server caches Finder information in RAM memory to
optimize performance. findercache specifies the number of Finder
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entries to cache, and thus the amount of RAM needed that should
be allocated for this purpose. Higher values require more RAM but
lead to a file server speed improvement for some Finder operations.

Note: Each entry requires about 100 bytes of RAM. The cache is
used by only one single “afpsrv” (i.e. client) at a time, since it
cannot be shared.

allowfpsync bool FALSE

Synchronize files to the file system when requested by Apple Time
Machine. The default is FALSE because server volumes are consid-
ered as stable storage, and synchronizing many times per second
slows down the overall server performance.

filedatesync bool FALSE

Whenever you modify a Mac file, the changes you make do not
necessarily affect both the data file and resource file, and in many
cases only the data file is changed. “afpsrv” only checks the modi-
fication date of the data file when it needs to display date and time
information in the Finder. However, “afpsrv” does normally not
update the modification date of the resource file if only the data
fork has been modified. The modification date of the resource file
is usually not important, even to incremental backup procedures,
and updating it would waste system resources and slow down the
file server somewhat. Nonetheless, situations may exist where
differences between the modification date of the data and resource
files can cause difficulties.
Such situations are typically those involving automatic data migra-
tion to slower external storage.
Specify the filedatesync flag to cause “afpsrv” to always synchro-
nize the modification date of the resource and data files, even if
only the data fork has been modified.
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sortdirs bool FALSE

This preference sorts the directories coming from the server to the
Mac clients by name.

dirmode int (see description)

This preference specifies the permissions for new directories. If not
set or set with the value “0”, it has no effect. If set with a value that
is different from zero it overrides the HELIOS smart permissions
as well as the useunixperm preference (see HELIOS Base manual).
Example:

Permissions for all newly created directories: drwxr-x–- (750):
$ prefvalue -k 'Programs/afpsrv/dirmode' -t int 0750

Specifying the permissions similar to the “chmod” command,
it is important to add a leading zero to the number:
$ chmod 700 mydir
$ prefvalue -k 'Programs/afpsrv/dirmode' -t int 0700

Note: On UNIX systems, directory file permissions (not only of new
directories) are also affected by “umask”. If directories are
created with unexpected permissions, it it advisable to check
the “umask” of “afpsrv”.

groupwriteisowner bool FALSE

In the Mac OS file system only the owner of a folder or volume
can permanently change the folder’s layout, e.g. sorting order, icon
placement, and label settings. This feature has been added to allow
workgroups, e.g. users who are all members of the same group, to
change layout settings or labels according to the organization of
their work.

fakeoffspring bool TRUE

By default, “afpsrv” will return the number of offsprings (entries
in a subdirectory) as 9999 when enumerating a directory. This
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option can be turned off by using this flag set to FALSE. Then, the
AFP call “GetFileDirParms” on a directory gives the real number
of entries.
This feature is especially useful if folders containing many subfold-
ers, which on their part may contain many files, are in use. The
Mac Finder or the application program, will not only request file
information in the current folder but also on files in subfolders,
although this information is currently not used. Therefore, this
option may accelerate the opening and displaying of folders with
many subfolders. There are few Mac applications which rely on
the exact offspring count. For those, disabling of this preference
may be required.

fullfakeoffspring bool FALSE

Allows further aggressive caching but is turned off by default be-
cause some applications may have problems with it. Affected
applications are some JavaScript apps, some Basic apps, and the
OS X 10.6 Finder as well as Mac OS 9.

translateany bool FALSE

This preference will cause line end translation for all files of type
“TEXT”, without regard to creator.

texttran bool FALSE

The texttran flag has been added to “afpsrv” in order to turn off
the newline translation for all types of text files. texttran set to
FALSE will disable line end translation for all files of type “TEXT”,
without regard to creator.
This feature may be helpful in case Mac applications do write
binary data into text files.
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Note: Starting with Mac OS 9, client applications including “Finder”,
do create/copy files on a server volume with a temporary type
instead of the final type “TEXT”. Only after writing the file
completely, the temporary type is set to the final “TEXT” type.
Due to this changed behavior, EtherShare can convert line
endings only when they are read from the server, but not when
files are stored on the server.

connectlimit int 0 (i.e. ∞)

Specifies the time in seconds a Mac client is allowed to stay logged-
on to “afpsrv”.

afpport int 548

Specifies the AFP port number via TCP/IP.
If port 548 is busy because the Apple file server runs also on this
server, “afpsrv” uses a random free port, which is logged in the
system messages where you can connect to.

dsiblocksize int 131072 (128 x 1024)

Specifies the maximum size of AFP TCP/IP data packets that are
passed from “afpsrv” to workstations through the network during
a transaction.

volstatinterval int 10

Specifies the time interval in seconds how often “afpsrv” checks
the amount of free space on the server.

volcheckinterval int 10

Specifies (in seconds) how often volstatinterval is communicated
to the Mac client.

ipaddress str ""

Specifies the IP address the “afpsrv” program offers to the Mac
clients for logging in via IP-protocol. (If this value remains un-
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specified, i.e. empty, all IP addresses on all network interfaces are
offered.)

ipaddresses str ""

This preference is applied for handling more than one IP address,
and is given out in a string in which the addresses are specified
comma-separated.

ip bool TRUE

This flag switches the AFP TCP/IP on or off, depending on its
setting.

ipaccess str "var/conf/ipaccess"

Specifies the path of the file containing the access list with the IP
addresses which are permitted to log on to “afpsrv”.

logdenied bool FALSE

If set to TRUE, this preference lets “afpsrv” append a record to the
system messages if, due to the IP access list, access to one or more
users has been denied.

dsitickletime int 30

Specifies the time interval in seconds after which “afpsrv” sends a
tickle packet to signal that the server is still running.

xferlog str ""

Specifies the path to the “xfer.log” log file. If set, the file names
of all files edited (written, read, saved, etc.) in HELIOS volumes
are recorded and stored sequentially in an “xfer.log” file. In gen-
eral, folder operations (new, move, rename), file moves within a
volume, file name changes, and file deletions are not logged. Nor
are operations under UNIX or from PC clients.
Use this option with care since it causes considerable load on the
server. This information is stored in the “xfer.log” file, in the
same format as used by FTP server log files. Each server entry
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is composed of a single line, consisting of the fields described
in the following table, with the fields separated by spaces. If the
path to the file “xfer.log” points to the same log file (typically in
“/usr/adm”) as used by the FTP server daemon (ftpd(8)), and “ftpd”
logging is enabled, then both FTP and “afpsrv” file operations can
be recorded in the same log.
Make sure an empty “xfer.log” file exists at the specified location
and set file permissions sufficiently so that “owner”, “group”, and
“others” can write to that file.
current-time

Current local time in the form DDD MMM dd hh:mm:ss YYYY.
Where DDD is the day of the week, MMM the month, dd the
day of the month, hh the hour, mm the minutes, ss the
seconds, and YYYY the year

transfer-time

Total time in seconds for the transfer
remote-host

Remote host name.
file-size

Size of the transferred file in bytes
filename

Name of the transferred file
transfer-type

Single character indicating the type of transfer. Can be
one of:
a for an ASCII transfer
b for a binary transfer

special-action-flag

One or more single character flags indicating any spe-
cial action taken. Can be one or more of:



84 9 Preferences

C file was compressed
U file was uncompressed
T file was tar’ed
_ no action was taken

direction

Direction of the transfer. Can be one of:
o outgoing
i incoming

access-mode

Method by which the user is logged-in:
a (anonymus) Anonymus guest user
g (guest) Passworded guest user
r (real) Local authenticated user

username

Local username or if guest, the ID string given
service-name

Name of the service being logged, usually AFP
authentication-method

Method of authentication used. Can be one of:
0 none
1 RFC931 Athentication

authentication-user-id

User ID returned by the authentication method. An *
is used if an authenticated user ID is not available.

completion-status

Single character indicating the status of the transfer.
Can be one of:
c complete transfer
i incomplete transfer
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lowdelay bool FALSE

Setting this preference to TRUE (IP type of service: Low Delay)
will let the host send IP-datagrams for “afpsrv” processes with
higher priority and lower delay compared to IP-datagrams of other
processes which did not set lowdelay. The exact behavior depends
on the protocols configured queueing discipline.

usexattrs bool TRUE

This preference decides if the AFP server uses extended attributes
(“xattrs”) for Finder tags, file metadata, file and folder security
information, etc. The attributes are saved as an extra file stream,
therefore Mac, Windows and “dt copy” will preserve this additional
information when copying files.

9.2 PAP server preference keys

The following keys require a restart (see “srvutil” in the HELIOS Base manual) of
the service to take effect:

Key: Programs/papsrv/<preference>

tcpport int 2007

Address of the master TCP port. All active TCP printers (printers
with active tcpname and TCPPublish flag) can be reached via this port.
If the port number is set to 0 the master TCP port is deactivated.

interfaces str ""

Specifies an IP address for the master TCP port. The “papsrv”
will listen on this interface for TCP connections to the printers and
registers its TCP printers for this address.
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A Files in the HELIOS directory

The following directory listing shows all files pertaining to EtherShare:

Note: Not all items described below are available on all supported platforms.

HELIOSDIR/bin

The “HELIOSDIR/bin” directory contains all available applications and tools,
e.g. the user utility program: “copy2x” (on macosx86 platforms only!).

HELIOSDIR/etc

The “HELIOSDIR/etc” directory contains additional installation files in the
subdirectories “install”, “uninstall”, “licversions”, “modes”, “prefs”, “runonce”,
“startstop”, and “updates”.

HELIOSDIR/lib

“HELIOSDIR/lib” contains library files and other resources which are shared
by all applications.

HELIOSDIR/public

The “HELIOSDIR/public” directory contains Mac applications in the directory
“MacOS”. The applications are available to remoteMac users via the “HELIOS
Applications” volume.

HELIOSDIR/sbin

The “HELIOSDIR/sbin” directory contains applications which are automati-
cally started by the server: “mount-afp”, “rmtrash”, “afpsrv”, “convertvol”,
“converthome”, and “papsrv”.



88 A Files in the HELIOS directory

HELIOSDIR/var/spool/dicts

The “dicts” directory contains the corrected Apple dictionaries:

_AppleDict_md__68_0

_AppleDict_md__70_0
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B Glossary

AFP server

File server using the Apple Filing Protocol (AFP).

Connect to Server

A program provided by Apple for Mac computers under OS X which allows
the user to choose a server for a particular service such as storing files. For
choosing a printer from the workstation, the Apple Printer Setup Utility (see
below) is used.

Finder

A part of the Mac operating system provided by Apple for Mac computers.

ImageServer

ImageServer is a HELIOS product that can do server-based OPI image conver-
sion, ICC color transformation as well as OPI replacement and printing. In
addition, it incorporates a powerful script server to automate workflows.

NVE

A Network Visible Entity (NVE) is a resource that is addressable through a
network. Typically, the NVE is a socket client for a service available in a node.

PCShare

PCShare is a high-end SMB-based file server and print server software for
Windows computers which are attached to UNIX computers through Ethernet,
etc. Since PCShare is compatible with EtherShare and WebShare, Windows
users can share network printers and files with Mac, Web, and UNIX users,
too.
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TCP/IP

An internet network is a virtual data network specification based on a packet-
oriented protocol (the internet protocol) which allows data to be transferred
between otherwise incompatible networks. Thus, the internet specification
describes a hardware-independent data protocol that lies above the hardware
protocol (such as Ethernet). The Internet Protocol (IP), however, is only able to
exchange data packets between computers. The Transmission Control Protocol
(TCP) extends this ability to allow processes to be addressed on the target
computer and to improve the reliability of the inter-process communication.
TCP/IP has been implemented by all major software and hardware providers.

WebShare

WebShare is a high-performance HELIOS file server which enables fast and
secure real-time file access via any web browser. SinceWebShare is compatible
with EtherShare and PCShare, intranet web users can share files with Mac,
Windows, and UNIX users.

HELIOSWebShare enables fast and secure real time remote file access via any
web browser. Now authorized users can easily use your file server wherever
they are, without exposing the server to the Internet.
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